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role is to guide organisations 
through this transformation 
and instil trust in 
sustainability data. Doing 
so will ultimately benefit 
both the bottom line and the 
planet.

  y People: The workforce 
is evolving and so is the 
management accounting 
profession. Let’s make 
sure that anyone with the 
aptitude and dedication to 
join the profession has the 
opportunity to do so and 
that the pathways for this to 
happen are fit for the digital 
age and relevant to the next 
generation.
 

Leading the profession
Fundamentally, I believe that we 
as a profession have a bright 
future ahead if we tackle these 
challenges head-on and treat 
them as the growth opportunities 
they are.

Many organisations have 
already shown first-hand the 

THE VIEW FROM THE PRESIDENT

SIMON BITTLESTONE, FCMA, CGMA 

KEEP IN TOUCH
Follow me on X

(formerly Twitter):
@CIMA_President 

#AccelerateAndLead

Preparing for  
the future

‘The world of finance and 
accounting is undergoing three 

profound transformations.’

First, I’d like to thank you for 
placing your trust in me to 
be the president of CIMA 

and chair of the Association of 
International Certified 
Professional Accountants.

I feel privileged to lead an 
organisation that does such 
important work driving 
opportunity, trust, and prosperity 
around the world. It is a great 
honour, and I will endeavour to 
act as a responsible guardian for 
our profession over the course of 
my term.

CIMA and the Association have 
played an important role in my 
career. I became a member in 
2009 and was admitted to 
fellowship in 2016, before joining 
CIMA Council in 2018 and the 
Association’s board of directors in 
2021. It is wonderful to be able to 
give something back to a 
profession that has been so 
important to me personally.

 
Accelerating progress
I want to use my time as CIMA 
president and Association chair to address the big 
issues we are facing as a profession and to prepare us 
for the opportunities of the future. The world of 
finance and accounting is undergoing three profound 
transformations, which also offer our profession 
enormous opportunity: 
  y Technology: Artificial intelligence (AI), 

including generative AI, and robotic process 
automation are revolutionising how we work. 
Our profession is on the cusp of a great leap in 
productive potential if we harness these new 
capabilities properly. As finance professionals, 
equipping ourselves with the digital mindset 
to be open to these technologies will create 
enormous possibilities.

  y Sustainability: We are at a key moment in terms 
of environmental stewardship. Businesses are 
working to integrate sustainability into their 
strategies, operations, and decision-making, and 
new regulation is enforcing this process. Our 

power that AI has in transforming finance activities. 
Similarly, think of the value we can add to the use of 
sustainability data by applying our core management 
accounting capabilities of strategic decision support 
and performance management to this area.

Above all, in leading the profession, we will focus 
on what CIMA and the Association can offer the next 
generation of young people: the educational pathway 
that can unlock a fascinating and rewarding career, 
driving the organisations of the future forward and 
making a better world. That is an inspiring purpose, 
and you will be hearing me talk about it a great deal 
over the next year.

It is for these reasons that I am excited to begin my 
journey as the 91st CIMA president, and I hope to meet 
as many of our members and candidates as I can over 
the course of my term. It is thanks to you that our 
profession is able to contribute so much to so many 
organisations around the world. Together, we will 
accelerate and lead our profession into the future.

https://x.com/cima_president
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A strategic 
approach to 
value creation 
By Andrew Harding, FCMA, CGMA

Andrew Harding, FCMA, CGMA, is chief 
executive–Management Accounting at 
AICPA & CIMA, together as the 
Association of International Certified 
Professional Accountants.

O ne of the reasons I believe our 
profession has such a bright 
future is the way we are 
increasingly stepping up to an 
enhanced role, guiding the 

strategic direction of the organisations we 
serve. And it is not just me saying it. 

The latest iteration of our Future of 
Finance 2.0 research, Re-defining Finance 
for a Sustainable World, found that 
accounting and finance professionals are 
increasingly focused on value-creating 
activities, looking for ways to optimise 
business models for long-term success. 
This evolution of our role is, in part, a 
consequence of the increasing 
capabilities of digital technology. 
Artificial intelligence, with its potential to 
increase process efficiency and improve 
decision-making, is a part of this. 

Routine tasks, which used to take up 
so much time, are increasingly being 
automated, and, as the tech improves, 
this trend will accelerate. It frees up time 
for us to use our skills and knowledge to 
focus on strategic decision-making and 
adding value to the business, which is a 
good place to be.

It should go without saying that in an 
increasingly data-driven and AI-enabled 
world, our digital and data skills and 
knowledge are a premium asset that we 

can capitalise on to create long-term 
value. Look at the growth in sustainability 
data. The increasing mandatory reporting 
requirements are just one part of this. 
High-performing companies are now 
measuring both financial and 
nonfinancial information with the same 
rigour because it will be another source of 
competitive advantage. This is just one 
example of the many areas where we will 
find our skills in demand in the future.

Finance business partnering
A consequence of putting greater focus 
on strategic value-adding work is that 
there is a higher demand for accounting 
and finance professionals in business 
partnering roles than for those who 
work in more traditional finance 
functions. As organisations adapt to 
an ever-more dynamic and uncertain 
environment, the need to continually 
align processes with strategic goals 
will increase. The companies that will 
succeed in this environment are the 
ones that effectively break down silos 
and share the expertise of their finance 
teams with partners in every other part 
of the organisation. 

You can see this reflected in workplace 
attitudes. Our Future of Finance research 
found that 60% of accounting and finance 

professionals surveyed identify as 
finance business partners, and 84% of 
those are extremely optimistic about the 
future of the profession. Of the 40% who 
don’t identify as a finance business 
partner, only 15% say they are optimistic 
about the future of the profession.

As with any change in the workplace, 
we need to think carefully about what to 
do next when it comes to upskilling. The 
move to business partnering and playing 
a more strategic role requires the ability 
to use data, analytics, and AI, combined 
with business acumen to improve 
strategic decision-making and drive 
business performance. I strongly 
recommend you look at our free 
Transformative Skills Pack, in particular 
the Strategic Thinking Mindset. It will 
help you determine strategic approaches 
and apply the strategic planning and 
management process to vital business 
decisions. These are exactly the skills that 
will help future-proof your career.     n

https://www.aicpa-cima.com/resources/landing/future-of-finance-2-0
https://www.aicpa-cima.com/resources/landing/future-of-finance-2-0
https://www.aicpa-cima.com/resources/landing/finance-business-partnering
https://www.aicpa-cima.com/resources/landing/finance-business-partnering
https://www.aicpa-cima.com/resources/landing/transformative-skills-pack
https://www.aicpa-cima.com/cpe-learning/course/transformative-skills-pack-and-strategic-thinking-approach-to-strategy
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A risk management expert shares insights on 
how management accountants can contribute 
to building their company’s strategic  
and operational resilience.

By Raluca Stroe

Steps to take to 
build business 
resilience
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C ompanies need to be 
resilient in today’s 
dynamic and uncertain 
environment, where rapid, 
more frequent, and more 

complex change is the norm. That 
means they need to manage risk, see 
business opportunities in adverse 
situations, and have a workforce that 
can adapt and learn from mistakes. 

Management accountants can 
contribute to building their companies’ 
resilience. Rodrigo Silva De Souza, Ph.D.,  
the author of the CIMA-sponsored 
research, Building and Enhancing 
Organisational Resilience: Before and After 
COVID-19, explains how in the Q&A below.

De Souza is a senior lecturer at the 

University of Roehampton in the UK, with 
a research focus on resilience and 
enterprise risk management. He is also a 
co-chair of the Institute of Risk 
Management’s (IRM’s) Innovation Special 
Interest Group, which in 2021 published a 
risk manager’s guide to organisational 
resilience.

His responses have been edited for 
length and clarity.

How do you define business 
resilience? 
De Souza: According to the BSI (British 
Standards Institute), organisational 
resilience is “the ability of an organisation 
to anticipate, prepare for, respond, and 
adapt to incremental change and sudden 

disruptions in order to survive and 
prosper”. I would add “recover and learn” 
to this definition. 

The IRM proposed a distinction 
between two areas of organisational 
resilience: operational resilience and 
strategic resilience. Operational resilience 
refers to the activities performed by each 
control function, traditional risk 
management techniques such as risk 
analysis, assessment, monitoring, and 
reporting, which alone are not sufficient. 

To achieve long-term resilience, 
functions must work together to enhance 
strategic resilience capabilities, which are 
obtained by (1) focusing on activities that 
add value to the company’s functions and 
strategy, (2) creating a culture that 

https://www.aicpa-cima.com/resources/download/building-and-enhancing-organisational-resilience-before-and-after-covid-19
https://www.aicpa-cima.com/resources/download/building-and-enhancing-organisational-resilience-before-and-after-covid-19
https://www.aicpa-cima.com/resources/download/building-and-enhancing-organisational-resilience-before-and-after-covid-19
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enhances resilience capabilities, 
balancing threats and opportunities, and 
financial and nonfinancial goals, and (3) 
enhancing the communication 
throughout the company by drawing on 
the wisdom of the crowds and/or 
real-time data analysis. This framework 
enables companies to jump from a 
compliance to a value-add mindset. 

What steps can companies take to 
achieve a strategic approach to 
resilience? 
De Souza: Organisations must define 
what they want to be resilient against and 
know that there’s no such thing as full 
resilience. For example, companies may 
have been resilient against fires, floods, 
and system failures for years, but climate 
change and badly executed digital 
transformations can knock them down.

To be strategic in their approach 
towards building and enhancing 
resilience, companies must: 
1. Understand the maturity of their 

current resilience capabilities. 
2. If the company has already 

developed some level of resilience 
and is comfortable with it, it is 
important to continuously monitor 
the level of preparedness and 
ability to respond to crises. War 
games and stress tests can support 
companies in this task, enabling 
control functions to assess if the 
current resilience capabilities are 
in accordance with the board’s 
expectations and risk appetite. 

3. Resilience is not only about 
anticipating and preparing for 
disruptions. Despite managers’ 
best attempts, failures will happen, 

and events may cascade into crises 
that exceed business contingency 
capabilities. Thus, although proactive 
resilience is desirable and ideal, 
reactive resilience is necessary. 

4. After the turmoil, it is time to 
reflect, act according to lessons 
learned, and create metrics that are 
“crisis-specific” to monitor ripple 
effects from the original shock.
By sharing information across the 

business, teams can map system 
interdependencies and enhance supply 
chain (strategic) resilience. Companies 
should break down the silo mentality 
permeating their operations and 
understand the multidimensionality of 
events. Cross-functional and hierarchical 
teams operating with the same goal, but 
using different skills and experiences, 
tools, and techniques to tackle a problem, 
enhances strategic resilience capabilities. 

In what three ways can management 
accountants contribute to building 
their business’s resilience? 
De Souza: Management accountants need 
to establish ways to measure resilience.  
For instance, there has been a huge 
emphasis on financial and operational 
resilience recently. Thus, liquidity ratios 
and Monte Carlo simulations, which are 
complex quantitative data analyses that 
model potential outcomes from a random 
chain of events, can be used to stress-test 
parameters and evaluate how companies 
would perform under extreme operational 
or economic conditions. 

Some abrupt or continuous disruptions 
may impact organisational resilience,  
such as the collapse of a supplier, poor 
communication, or toxic work 

environments. Management accountants 
should create metrics to monitor and 
assess current and emerging risks and find 
blind spots in current measurements 
against resilience frameworks such as ISO 
(International Organization for 
Standardization) 22316 and BSI 65000.

Management accountants should also 
assess performance evaluation systems to 
improve collaboration across functions 
and hierarchies. The siloed mentality is 
still an issue, which leads to double work 
and a lack of communication and 
collaboration between the first, second, 
and third lines of defence made up of 
management, risk and control monitoring, 
and independent assurance by the internal 
audit function. 

Performance measurement systems 
can be put in place to facilitate this 
interaction and knowledge sharing. They 
include risk-based performance metrics 
and socially based feedback systems, such 
as 360-degree reviews, employee surveys, 
and peer reviews.

Finally, management accountants may 
need to go beyond reliance on past 
performance and create and monitor 
real-time data regarding internal, 
sector-wide, and world trends. This  
can be done using the wisdom of the 
crowds, horizon scanning, scenario 
analysis, and war games. That would 
enable companies to assess their level of 
preparedness to perform under new 
extreme economic conditions created by, 
for example, high inflation and 
sociopolitical instability, and meet 
stakeholder demands for, among other 
things, low emissions, fair trade, and 
remote work.

 
For both operational and strategic 
resilience, what role does culture 
play? 
De Souza: The right culture means all have 
the responsibility to quickly report and 
work on incidents. This collaboration 
across hierarchies and functions increases 
the speed of communication and 
enhances knowledge sharing, enabling 
companies to anticipate, prepare for, 
respond to, adapt, recover, and learn from 
shocks and crises. 

During the COVID-19 pandemic, for 
example, most companies that succeeded 
did so through collaboration and a sense of 
purpose — thus, people and culture are 
key. In moments of crisis, these factors 
will enable companies to find alternatives 

— Rodrigo Silva De Souza, Ph.D., a senior lecturer at the University 
of Roehampton in the UK

‘Companies do not need to 
wait for crises or regulations 
to build up resilience 
capabilities.’
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LEARNING RESOURCES

Business Continuity Management

This course covers the steps needed to implement a comprehensive 
business continuity plan — including business impact analysis — to 
ensure resilience, even during a crisis such as a global pandemic. 

  COURSE

The Future-Ready Finance & Accounting Professional  
— Welcome to the Fast Future

This session will show how to anticipate trends and move from 
being a crisis manager to an opportunity manager. 

  COURSE

Raluca Stroe is research and development manager at AICPA & CIMA, together 
as the Association of International Certified Professional Accountants. To 
comment on this article or to suggest an idea for another article, contact  
Oliver Rowe at Oliver.Rowe@aicpa-cima.com. 

and an escape route; after crises, to learn 
from what has happened; and before 
crises, they can anticipate threats and 
opportunities, scanning the horizon and 
testing capabilities to see what can be done 
better. To do that, we should rely on the 
power of real-time data analysis.

And what is the role of governance? 
De Souza: Boards need to support an 
organisational resilience proposition. 
Effective collaboration across control 
functions, from top management to 
different hierarchies, is crucial. 

This enhances the understanding of 
what challenges and/or opportunities are 
coming next and provides resources to test 
capabilities and envision and quantify 
scenarios. Without support from the 
board, there is a danger that resilience 
becomes a tick-box exercise only. 

Our CIMA-sponsored research shows 
that exposure to previous crises and 
regulatory requirements can work as 
triggers to enhance awareness and move 
organisations beyond inertia. Regulation 
may prompt companies to adopt 
minimum standard requirements, but also 
to proactively visualise other potential 
disruptions. Thus, even if it is compliance-
driven, regulation may still enhance 
organisational resilience. Additionally, 
when crises or disruptions occur at a time 
or place with great impact on a company, 
they can enhance awareness. Surprisingly, 
a global systemic crisis, such as COVID-19, 

may also create laissez-faire among parties 
and a false sense of security. In times of 
crisis, organisations can become reliant on 
external factors such as government 
support, financial aid, or industry-wide 
relief measures and relax standards and 
compliance.

However, companies do not need to 
wait for crises or regulations to build up 
resilience capabilities. The senior 
management team can set the direction, 
and an extended enterprise risk 
management framework may enhance the 
understanding of interconnections, which 
is essential to manage resilience 
proactively and strategically.

Which risks should be current 
investment priorities? 
De Souza: Currently, I would focus at least 
on the following areas: generative AI, 
sustainability, and sociopolitical 
instability. 
  y ChatGPT is only the tip of the 

generative AI iceberg. Many solutions 
(with their potential risks) are being 
created. They will impact areas such 
as automation and remote work, 
individuals’ privacy, medicine, 

technological developments, 
finance, and accounting. These 
changes will develop exponentially 
as technological developments 
are running in parallel and are 
decentralised. Thus, the magnitude 
and speed of changes may reach your 
company earlier than expected. 

  y Sustainability is no longer simply 
an issue but an imperative. Is 
your company prepared to deal 
with more frequent and worse 
climate scenarios? What about 
your suppliers? What have been 
your/their values and priorities? 
Companies will face increasing 
scrutiny regarding climate resilience, 
which encompasses operational, 
financial, and strategic aspects of 
organisational resilience. 

  y The underlying assumptions of our 
decision-making and risk assessment 
models may make them inaccurate 
when answers are most needed 
(such as in times of uncertainty, 
instability, or crisis). The problem 
with geopolitical conflicts, for 
example, is that they trigger many 
other risks, such as high inflation, 
social insecurity, and socioeconomic 
uncertainty. During instability, this 
network of events needs to be more 
closely scrutinised and monitored, as 
it may radically change investment 
and other decisions.   ■

AICPA & CIMA resources
Articles 
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20 November 2023

“People-Centric Leadership Can 
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“Expect the Unexpected: Risk 
Assessment Using Monte Carlo 
Simulations”, Journal of Accountancy,  
1 November 2017
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Raising questions and supporting and expanding 
research capability are some ways generative AI is 
making its mark on strategic decisions.

By Andrew Kenney

What gen AI means 
for executive 
decision-making
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But many individual finance leaders, including Ezzat, have 
started with much smaller experiments. They’re finding ways that 
emerging technologies can expand the depth and breadth of an 
executive’s decision-making process — and they’re learning to 
work around the technology’s shortcomings.

In a series of interviews for FM, Ezzat and other finance leaders 
shared their early impressions of how AI could support strategy 
and leadership.

“If you are not learning yet about ChatGPT and AI tools, how 
[they] work, and how to integrate [them] with your system, I think 
it’s almost too late,” Ezzat suggested. “If you didn’t start yesterday, 
start now.” 

Starting small: How finance leaders are applying gen AI
For some finance leaders, generative AI agents have already 
become a personal tool for planning, analysing, and 
communicating clearly.

As Ezzat reviews a startup’s proposal, he might ask ChatGPT to 
review the basics of its business pitch. Then he’ll ask the system 
to apply business frameworks, such as a strengths, weaknesses, 
opportunities, and threats (SWOT) analysis or Porter’s Five Forces, 
to the proposed business model.

For others looking to test generative AI tools, remember to 
review assurances from the tool provider regarding data privacy, 
security, and ownership before uploading documents or making 
statements that may contain confidential or sensitive 
information to a generative AI system.

A hmed Ezzat, ACMA, CGMA, is rather busy.
He’s the CFO of a venture capital and private-

equity company in Saudi Arabia. The company 
manages a significant portfolio of investments 
across various sectors with a streamlined team.

Ezzat’s role includes participation on multiple startup boards, 
helping guide their strategic direction. Part of his work involves 
evaluating numerous investment applications each year, 
leveraging advanced technology to enhance the assessment 
process and ensure a comprehensive analysis of potential 
investments. 

“Managing extensive data is challenging, and we continuously 
refine our processes to capitalize on potential opportunities 
effectively,” he explained in a recent interview with FM. “The 
investment decision is critical, especially for a tech company in 
the early stage.”

In recent years, as part of his company’s tech-forward 
approach, Ezzat has been using generative AI to augment his 
reviews of companies seeking investment — looking for the 
strategic strengths and weaknesses in scores of startups.

It’s part of a larger trend: Finance leaders, executives, and 
board members are trying to use generative AI and machine-
learning tools to augment strategic decision-making, and 
technology companies are racing to help them.

Some companies have even appointed AI systems as virtual 
advisers to their boards, with the promise of surfacing hidden 
trends and steering a company’s financial future. 
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Often, Ezzat has found the AI makes astute observations.  
For example, one startup was selling a financial service for 
consumers. 

“I liked this idea,” Ezzat said, adding that he could imagine 
using such a service. But the AI quickly surfaced a concern: The 
business model had low barriers to entry.

“ChatGPT came back and said, ‘This market is very easy to 
enter by other competitors,’ ” he said.

Indeed, when this writer gave ChatGPT a description of the 
same business model and asked it to run an analysis, the AI bot 
produced the same concerns. It also listed several other risks — 
such as cultural resistance to change, interest rate sensitivity, and 
the risk of overextending credit to consumers — as well as several 
sensible strategic recommendations.

None of the AI ideas were all that original. Ezzat, with his 
experience, surely would have thought of them himself. But the 
software agent raised worthwhile questions and successfully 
drew connections to numerous related concepts and ideas.

In turn, Ezzat immediately knew what questions he wanted to 
ask the startup’s founders. He believes AI’s role for leaders will be 
“enhancing their ability to process and analyse vast amounts of 
information and align this information with a company’s 
strategic plan”.

Other finance leaders are using AI in similar ways to generate 
ideas, to raise questions, and to support and expand research to 
streamline the strategic planning process (see the sidebar, “Using 
AI as a Research Assistant”).

No matter how they use it, finance professionals should 
keep in mind that using generative AI-sourced information 
without ensuring its validity may complicate their fiduciary 
duties. If the software’s methods and inner workings are 
unclear, but they are relying on it to make decisions, it may 
raise questions about ethics and standards, warned Russell 
Tucker, ACMA, CGMA, group finance manager for a multi-
family office in England. 

Many finance leaders are using consumer-grade AI products 
like ChatGPT as research assistants — skimming through 
materials to surface key ideas. As a research tool, AI can help: 

1. Quickly digest large datasets
“I think it’s really good in terms of digesting information,” 
said Russell Tucker, ACMA, CGMA, group finance manager 
for a multi-family office in England. “For me it’s processing 
articles, PDFs, books — getting through the data, in order to 
speed up that process for me, because obviously, day to day, 
we’re really busy.”

2. Streamline your searches
An AI query can sometimes prove more efficient than a web 
search. Traditional search engines lead to webpages that 
could be out of date, are loaded down with ads and paywalls, 
and may or may not answer your question.

At its best, generative AI can directly answer a question by 
tailoring its knowledge base to constraints provided by the 
user. No surfing required.

3. Clearly communicate your findings
Generative AI can also help with explaining research and 
ideas to others. Tucker uses it to simplify and summarise his 
writing.

“I’m a really technical guy. Sometimes, I’ll use it to try and 
bring things into a layman’s term and help present data in a 
different way,” he said.

4. Transcribe conversations
AI transcription services, such as Otter and Rev, don’t just 
produce written records of meetings. They also identify key 
insights and decisions made during meetings, which is 
helpful for executives who spend much of their day on Zoom 
or Teams.

Remember: Be cautious
Of course, these tools also have a reputation for making false 
statements. So, while their developers have worked to reduce 
“hallucinations”, fact-checking AI answers remains 
mandatory. 

An overreliance on AI can lead to not just misstatements 
but, potentially, strategic mistakes. While it can be helpful for 
basic questions and initial research inquiries, it’s unlikely at 
present to come up with truly novel ideas, and it may struggle 
with situations that are not addressed in its knowledge base, 
said Donny C. Shimamoto, CPA, CGMA, managing director of 
the CPA firm IntrapriseTechKnowlogies.

Using AI as a research assistant
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Could AI have a role on the board?
While finance leaders experiment with generative AI at a personal 
level, some companies have started to dream much bigger. Could 
AI itself take on enhanced strategic roles, especially on the board?

A Hong Kong venture capital fund said an AI system had an 
informal adviser role for its board of directors, and a major 
company in the United Arab Emirates has done the same.

But some finance experts remain sceptical of the idea that AI 
will advance into a true leadership role anytime soon.

“I struggle to believe there’s an all-singing, [all]-dancing AI 
member that can hit all professions and functions appropriately,” 
said James Owen, FCMA, CGMA, global CFO, Profiles Division at 
Kantar.

Instead, he sees AI playing an information processing role — 
with potential strengths such as tracking board action and 
helping board members prepare for meetings.

“Everyone at the table will have had their pre-briefing from an 
AI-inspired source,” Owen predicted.

Generative AI could also become an interface for the board and 
other leaders to tap into a company’s deeper data troves and 
machine-learning capabilities. 

As the technology becomes more reliable, instead of 
depending on dashboards that highlight particular data series — 
or waiting for quarterly updates from staff — CFOs and board 
members could use natural language interfaces to simply ask an 
AI agent for specific analyses of large amounts of company 
finances, forecasts, and other data.

However, at least for now, the technology may not be as 
painless or powerful as it’s made out to be. For example, Microsoft 
has ambitious plans for its Copilot platform to tap into a 
company’s datasets to generate insights and content based on 
plain-language inquiries. 

But Owen cautions that in its early days, his company’s 
implementation of Copilot has required troubleshooting and 
oversight. The technology struggles if files and folders are not 
uniformly organised, he said.

LEARNING RESOURCES

Supercharging the CFO Office With AI

This webcast will discuss artificial 
intelligence (AI) and how it can be used 
in finance for forecasting and prediction.

  WEBCAST 
 

 
Unleash the Power of AI: An 
Accountant’s Guide to ChatGPT

In this course, you’ll learn how to use 
ChatGPT to streamline your workload, 
save time, and boost your overall 
efficiency.

  COURSE

Andrew Kenney is a freelance writer based in the US. To 
comment on this article or to suggest an idea for another 
article, contact Oliver Rowe at Oliver.Rowe@aicpa-cima.com. 
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It can’t always “make the linkage” between differently 
organised files and data, Owen explained. “It’s teaching us to be a 
lot more organised and a lot more sophisticated.”

It’s a symptom of a larger issue with implementing AI systems, 
and not just generative AI. “You need structured data for machine 
learning to be plugged into. And I feel there’s a lot of organisations 
still in the early part of that journey,” Owen added.

Preparing for AI-empowered leadership
Business technology companies are steadily incorporating 
generative AI into software most companies rely on, from cloud 
accounting platforms to enterprise resource management systems.

At the same time, deeper and more effective AI capabilities are 
being baked into consumer devices and software. 

The ultimate limits of this technology have yet to be 
determined. It may never reach the heights that some are 
promising today — a truly autonomous system that can execute 
complex tasks from start to finish.

However, it seems clear that generative AI already offers potent 
benefits for many of the tasks most important to executives: 
analysing, summarising, and communicating.

“You need to understand, not necessarily how does it work, 
but what can it do? What can’t it do?” said Donny C. Shimamoto, 
CPA, CGMA, managing director of the CPA firm 
IntrapriseTechKnowlogies.

Those answers should become clearer as the initial hype 
around generative AI dies down, Tucker said. “We can figure out 
where the limitations are and then implement the technology to 
reduce all the things that we do that are time wasting,” he said.

For Ezzat, there’s a twofold task ahead: Individual leaders need 
to improve their AI literacy, while organisations need to 
understand how generative and other types of AI can support 
their strategic decision-making.

“We need to identify specific areas where AI can close the gaps 
in decision-making and enhance strategic forecasts,” Ezzat said.

Within a matter of just a few years, these experts predicted, AI 
skills will be a key part of a leader’s skillset — if they’re not 
already. “We … need to take on AI and implement it in a way that 
we’re all empowered by it and not replaced by it,” Owen said.    ■

https://www.thenationalnews.com/business/technology/2024/02/27/ai-in-the-boardroom-why-it-could-change-the-way-companies-make-decisions/
https://www.aicpa-cima.com/cpe-learning/webcast/supercharging-the-cfo-office-with-ai
https://www.aicpa-cima.com/cpe-learning/course/unleash-the-power-of-ai-a-cpas-guide-to-chatgpt-sso
https://www.aicpa-cima.com/cpe-learning/course/unleash-the-power-of-ai-a-cpas-guide-to-chatgpt-sso
mailto:Oliver.Rowe%40aicpa-cima.com?subject=
https://www.fm-magazine.com/news/2024/may/chatgpt-use-cases-and-limits-to-its-reliability.html
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A digital transformation expert provides a road 
map for organisations, emphasising that the 
process should not be tied to grand plans or 
large capital allocations.

By Bryan Strickland

Why digital 
transformation 
is more about 
people than 
technology
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British parliamentarian and 
political economist Edmund 
Burke wrote in 1790 in his 
Reflections on the Revolution in 
France: “People will not look 

forward to posterity, who never look 
backward to their ancestors.” More than 
230 years later, those words ring true today 
for companies working to revolutionise 
their business model for the digital era.

“There’s data on this point — multiple 
studies showing that 70% of digital 
transformation efforts fail — which is 
really a sobering, scary statistic,” Columbia 
Business School faculty member, 
corporate consultant, and author David 
Rogers told FM. “So many companies are 

failing at this. What can we learn from 
those outliers who are succeeding?” he 
asked.

In his new book, The Digital 
Transformation Roadmap, US-based 
Rogers leans on lessons learned as a 
consultant to help guide companies 
through the daunting prospect.

History has taught him two surprising 
things: Digital transformations don’t 
actually have to be daunting. And, despite 
what the name suggests, digital 
transformations are more about people 
than technology.

“You need to get alignment across the 
different parts of the organisation, and 
that starts with having a common shared 
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vision of where you’re actually heading 
and why. What is it that is forcing you … 
or what’s the opportunity for you as a 
particular business … to change in this 
digital era?” Rogers said. 

He added: “Then, once people start to 
get on board and understand why we’re 
doing this and where we’re aiming for … 
as a leader, it’s critical that you look at the 
systems you have in place and make sure 
they are actually going to empower 
people to push you forward. Because you 
can’t do this all top-down; it can’t just be 
a lot of orders from the top. 

“You actually need everybody at every 
level pushing the change forward. That 
means you have got to remove the 
blockers, the red tape, and the 
bureaucracy of old systems that are 
getting in the way.”

A shared vision is the first of five steps 
that Rogers lays out in his road map. 
Technology isn’t mentioned in detail 
until within the fifth step:
  y Vision: Define a shared vision.
  y Priorities: Pick the problems that 

matter most.
  y Experimentation: Validate new 

ventures.
  y Governance: Manage growth at 

scale.
  y Capabilities: Grow tech, talent, and 

culture.

Ways to get started and progress
The five steps describe an iterative 
journey that Rogers recommends taking 
briskly. “Take your first pass-through in 
90 days. This is always my advice,” he 
said. “Try to take a stab at all five of these 
steps within the first 90 days of your 
transformation.”

Rogers added that during that first 
cycle you start to define the vision and 
direction of a project, which leads to the 
next steps and can be further refined in 
the next pass-through.

How you define your digital 
transformation strategy will differ from 
business to business. One business may 
want to focus on improving the customer 
experience to raise average revenue per 
customer; another may want to reduce 
risk in the supply chain, improve 
productivity, or change the business 
model, Rogers said. Once it becomes 
clear what drives value creation, then the 
success of your transformation can be 
measured and specific KPIs can be set.

“It’s really an iterative process of 
learning through doing,” he said. “It’s not 
about a big upfront planning process 
before you start. And it’s not about big 
budgets at the beginning. 

“Over time, as you start to learn what 
works for your market, you need to be 
ready to accelerate investment. But it’s 

the wrong mindset to say, ‘Well, we’ve got 
to build this big, detailed business case 
and spend a lot of preparatory time 
because we’re going to spend a lot of 
money.’ ”

When it comes to seed money, rather 
than leaning on “slow-moving systems of 
funding” aimed at one major financial 
investment in new technology, Rogers 
encourages companies to allot smaller 
pools of money that allow for rapid testing 
and learning along the way.

That’s another way Rogers works to 
help get companies off on the right foot 
— starting simply, by actually getting 
started.

“There’s a sign outside of the tree 
nursery down the road from our house,” 
Rogers said. “It says, ‘The best time to plant 
a tree: 20 years ago. The second-best time 
to plant a tree: Today!’

“I would actually say the same thing 
about digital transformation.”   ■
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A  
global poll of climate scientists 
published by The Guardian 
newspaper in the UK in May 
indicated that global 
temperatures could rise at least 

2.5 degrees Celsius beyond preindustrial 
levels during this century. That rise is 
expected by 77% of survey respondents, 
and almost half anticipated the increase in 
temperature to be a minimum 3.0 degrees 
Celsius.

The implications for the planet, its 
people, and business are profound — not 
least for the production of essential food 
crops, metals, and minerals.

A PwC report, Climate Risks to Nine Key 
Commodities, examines how drought and 
heat stress have the potential to negatively 
affect farming and mining of nine 
commodities the researchers consider 
“essential to the global economy”: 

  y Aluminium (from mined 
bauxite), iron, and zinc — used 
in manufacturing, transport, and 
infrastructure.

  y Cobalt, copper, and lithium — used 
in electronics and clean-energy 
technologies.

  y Maize, rice, and wheat — accounting 
for 42% of calories people consume 
globally.
The production risk is further 

complicated by the geographical 
concentration of production in a few 
countries and often a small number of 
regions within those countries. According 
to the PwC report, five mines (in the 
Democratic Republic of Congo) produced 
most of the world’s cobalt (2020 figures). 
And, globally, 81% of lithium, 50% of 
bauxite, and 44% of iron were each 
sourced from ten or fewer mines.

However, nearly half of CEOs (47%) are 
taking action to protect employees and 
assets from climate-related risks, 
according to the PwC report. 

The World Economic Forum — together 
with PwC — produced a framework to 
accelerate business action on climate 
change adaptation in three areas: (1) 
enhancing resilience by identifying and 
managing risks; (2) capitalising on 
opportunities; and (3) shaping 
collaborative outcomes.   n

The case for 
climate-change 
adaptation
Even a 2.0-degree Celsius rise in temperature this century could affect 
production of nine key food crops, metals, and minerals.
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Source: PwC report, Climate Risks to Nine Key Commodities — in a below-2.0-degrees-Celsius-increase scenario.

Commodity production risk in 2050
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To deal with this common issue, make sure you prepare well, ask questions 
during the meeting, and look for ways to include other participants.

By Rhymer Rigby

10 tips to overcome 
meeting anxiety
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F eeling anxious in a meeting is 
very common and, while it’s a 
particular problem for those 
who struggle with social 
anxiety, it can affect almost 

anyone. Most of us will have experienced it 
at some point, whether it’s because we’re 
unsure of the ground we’re on, we’re 
intimidated by others, or we don’t want to 
rock the boat. And, of course, all this is 
before we get to video meetings and hybrid 
meetings, which have their own 
challenges and pitfalls.

Here are steps to take to overcome  
the problem. 

Interrogate your anxieties
Why is it that you are nervous? Is it 
because you haven’t been in the job for 
very long? Is it because you find colleagues 

daunting? Is it because you don’t feel you 
know your subject? Make a list of reasons. 
Then, address them one by one. You might 
say to yourself, “Yes, I’m the least 
experienced person in the meeting, but I 
was hired for this position and may have a 
fresh perspective to offer.” Or, “I’m worried 
that I don’t know what to say, but I’m my 
team’s go-to expert on several areas.” 
Remember that you were invited to the 
meeting — and if they didn’t want you to 
be there, they wouldn’t have asked you  
to come.

Prepare in advance
One of the best ways to ensure confidence 
is to know your stuff. So, do your 
homework. Ahead of the meeting look at 
the agenda, ask for one if not provided, 
and ensure that you prepare for any topics 

you’re likely to be asked about.  
Preparing in advance means you’ll be 
less anxious about speaking, ready for 
any challenges, and more able to 
contribute to the general discussion. If 
you have a particular issue you want to 
raise, plan the point at which you’re 
going to speak and talk to any colleagues 
with whom you might want to 
coordinate beforehand.

Arrive a few minutes early
This applies to both real and virtual 
meetings. There’s nothing worse than 
walking into a room where a meeting is 
already underway, looking disorganised, 
dishevelled, and flustered. In a physical 
meeting, aim to be five minutes early 
— that way you look professional, you 
may be able to choose where you sit, and 
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you’ll be cool and ready when the meeting 
starts. For a virtual meeting, ensure you’re 
in a comfortable, suitable place that’s free 
of distractions — and that any technology 
you are using works, especially if it’s new.

If it’s a hybrid meeting
These are meetings where some people are 
physically present and others join by video 
or dial in. Here, you should try to be at the 
physical meeting if you can. A huge 
amount of communication is nonverbal 
and, by being in the room with others, you 
will be privy to far richer intelligence about 
mood, nuance, and how what you are 
saying is going down. These little signs are 
harder to pick up via video.

Be generous to others
If you want people to be well disposed 
towards you in a meeting, treat them as 
you’d like to be treated. When they speak, 
look at them, lean towards them, listen, 
and stay engaged, rather than going 
through your emails on your phone or 
staring out the window. It’s not rocket 
science, but they are much more likely to 
support you later on if you do this. 

Be generous to others when you speak, 
too. Rather than addressing everything you 
say to the chair or the most important 
person in the room, talk to everyone. Look 
for ways of including individuals — for 
example, you might say, “This project 
draws on the great work Jennifer did last 
year.” Do this and Jennifer will instantly be 
on your side.

Ask questions
One of the best ways to get used to 
speaking in meetings is to just ask a 
question. It doesn’t need to be 
confrontational — rather, ask someone 
to expand on a point or clarify 
something. Genuine questions tend to be 
appreciated, as they show that you’re 
interested and following what the person 
is saying. They’re also a great way to ease 
yourself into contributing to meetings.

Don’t over-speak
Nervous people often don’t know when 
to stop, so they rattle on long after 
they’ve made their point, which tends to 
undermine the good work they’ve done. 
So, if you only need to speak for a 
minute, speak for a minute and then 
stop. It’s far better to be thought of as 
brief and succinct than the person who 
talks forever. This is one of the reasons  
to practise what you’ll say. You’ll know 
the end point — and when you reach it, 
you stop. If people want more, they’ll ask 
for it.

Volunteer for a role
If you feel like an imposter in meetings, 
create an official reason to be there and 
give yourself a sense of purpose. Perhaps 
minutes need taking. Or an agenda needs 
preparing. Or a presentation needs doing. 
The person who does this can be you. 
This can start a virtuous circle where 
contributions and confidence feed on 
each other.

Follow up afterwards
An easy way to bring something positive to 
the next meeting is to ensure you follow 
up on agreed actions. Then, at the next 
meeting, you’ll be prepared (because you 
have done the task) and you’ll have a 
contribution, which you pretty much have 
to make.

Practise, practise, practise
There’s a strong element of “fake it until 
you make it” about speaking in public or in 
groups generally. The first few times you 
do it, it will be hard, and you’ll need to get 
out of your comfort zone. But slowly, as 
you become more practised, it starts to 
come naturally, and, as people react 
positively, you will become more 
confident. It’s a virtuous circle. If it helps, 
look up some videos of politicians 
speaking early on in their careers. Former 
US President Barack Obama, who is widely 
hailed as a great orator, was a lot less 
effortlessly fluent when he started out.

The more you participate in meetings, 
the more you’ll get out of them. Give it a bit 
of time and effort and you may actually 
find yourself looking forward to them.    ■
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Working with 
images in Excel
Excel has several features that relate to images — from extracting data 
from picture files, using the IMAGE function, to use with PivotTables.

By Liam Bastick, FCMA, CGMA IM
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I thought it was time to examine Excel’s features and updates specifically for images. There are several options, including 
how you can now obtain table data from pictures and how images may also be inserted into spreadsheet cells. There is 
also an IMAGE function for formatting pictures inserted in cells, and, believe it or not, you may now insert pictures into 
PivotTables, too. 

Let’s take a look — see also the example Excel file.

https://www.sumproduct.com/blog/article/a-to-z-of-excel-functions/the-image-function
https://www.fm-magazine.com/content/dam/fmm/issues/2024/aug/sp-excel-and-pictures.xlsx
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Get Data From Picture
Available in Excel for Microsoft 365, Excel is now able to extract data from pictures. Users may extract data tables from photos 
or screenshots. The option can be found in the Data tab, in Get & Transform Data -> From Picture using pictures either from 
a file or already copied to the Clipboard (see the screenshot “Extracting Data From Picture”).

Extracting data From Picture

This means it is now quite easy to take screenshots and import data into Excel. For example, see the screenshot “Sample 
Dataset” for a sample fictional dataset that our company SumProduct uses for modelling. 

Sample dataset

After I take a screenshot of it, I can then click the option Picture From Clipboard, described above, and Excel will start to 
load and analyse the picture.

Upon completion, the Data from Picture pane produces a data preview and highlights the values that need to be further 
verified by the user — see the screenshot “Data Preview — for Verification”.
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Data preview — for verification

You may then confirm or amend the highlighted cells (shaded in light red) and input the data into Excel as a range. As a tip, it’s 
always advisable to crop the image and only include the target area. In this case, you can see that Excel has detected a lot of 
unnecessary information. We only wanted the table. Therefore, allow me to repeat the exercise but this time crop the screenshot (in 
this example, I am simply using the Windows Snipping Tool) — see the screenshot “Cropping to Include Only the Target Area”.

Cropping to include only the target area 
 

I may then right-click to copy so that the picture is in our clipboard.
I then use Picture From Clipboard again to import the picture into Excel — see the screenshot “Data Preview — Revised”.
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Data preview — revised 

You will notice that Excel’s image recognition is not yet perfect, but, quite frankly, it is a lot better than several other options I have 
tried in the past. 

In particular, the Customer ID column requires further assistance, even cells that aren’t shaded red. I can try to review and amend 
as much as possible with the Data from Picture pane before inserting the data and making any manual corrections in Excel itself.

One useful feature of the Data from Picture pane is that it zooms its window to the relevant area when you click on a detected cell 
(hence the lower resolution in the source image in the screenshot “Zooming to Relevant Area From Detected Cell”), making it very easy 
for the user to cross-reference. 

Zooming to relevant area from detected cell
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Some text inputs (eg, ID numbers), once incorrectly entered as numbers, might be quite hard to guess and amend without returning 
time and again to the source data.

Albeit far from perfect, in this illustration at least, Excel still does an adequate job picking up much of the detailed information, 
such as Date, Store, Item, Salesperson, Amount Invoiced, and Amount Paid. That reduces the manual work required. (See the 
screenshot “Resulting Data in Excel”.)

Resulting data in Excel

You may also insert data from a graphic file, which provides more flexibility. For example, you can try to scan printed materials or 
even hand-drawn tables. Here is a list of graphic file types that may be inserted presently in Microsoft Office documents (correct as of 
the time of this writing): 

BMP, EMF, EMZ, EPS, FPix, FPX, GIF, JPEG, JFIF, JPEG-2000, PDF, PICT, PCT, PNG, PNTG, PSD, QTIF, SGI, TGA, TPIC, TIFF, TIF, WMF, WMZ.

Data from Picture does have some limitations: Excel scans numerical values more accurately and less so for text values or where 
there may be a combination of the two (eg, ID numbers). In addition, Excel scans printing-font tables reasonably well (either from 
screenshots or photos), but it struggles with handwritten data.

Furthermore, my team has noted that Excel’s Data from Picture feature would be useful for getting data from scanned PDF 
documents (as there are no searchable or selectable text but only images), especially where Power Query (Get & Transform) was 
unable to extract the data. In this instance, you can use this feature to extract data from these scanned PDF files, rather than having to 
manually read and input the data.
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Insert Picture in Cell
Another new feature of Excel is that you are now able to insert pictures in cells. This should not be confused with the legacy method of 
placing pictures on top of spreadsheet cells.

Placing a picture on top of spreadsheet cells is the default behaviour of Excel. Although Excel no longer allows pasting or drag-and-
dropping a graphic file, pasting an image from the clipboard still puts it on top of the cells, ie, as a Picture over Cells. (You may also use 
the Ribbon option: Go to the Insert tab and then select Pictures -> Place over Cells, where you may browse for a graphic file and other 
sources such as Stock Images in Excel or Online Pictures.

To return to the new feature: There are four ways to insert a picture into a cell:
1. Insert Picture in Cell from the Excel Ribbon;
2. Paste Picture in Cell from the Clipboard;
3. Switch from Picture over Cells to Picture in Cell; and
4. With the IMAGE function, using a web URL path.

The first option is to insert a picture into a cell from the Ribbon. Going to Insert -> Pictures -> Place in Cell provides you with 
several options to insert a picture into the active cell. There is the common option of browsing for a local graphic file, but there are also 
a few more different sources of pictures, too (see the screenshot “Sources of Pictures to Insert”).

Sources of pictures to insert

For example, Stock Images… offers a rich collection of different types and different themes of pictures.
You may also paste a picture into a cell from the Clipboard. Of course, you first need to have an image in the Clipboard. In the 

example of getting an online image, you may right-click to Copy image and then right-click on the cell to insert, using the Paste 
Picture in Cell option (last icon under Paste Options). (See the screenshot “Pasting a Picture Into a Cell From the Clipboard”.)

Pasting a picture into a cell from the Clipboard

The third way identified to put a Picture in Cell is to convert from a Picture over Cells. Here, I have prepared a racoon image floating 
over spreadsheet cells. When I right-click on the racoon, you will see the option Place in Cell — see the screenshot “Convert From 
Picture Over Cells Example”.
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Convert from Picture over Cells example 

Using this option places the racoon into the top-left cell of the region that it had been floating over (see the screenshot “Completing 
Convert From Picture Over Cells”).

Completing convert from Picture over Cells
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The final step, and probably the most technical method to insert a Picture in Cell, is to use the IMAGE function. This function offers 
different sizing options and also allows you to input descriptive alternative text. However, I will save this for later when I discuss the 
IMAGE function and its applications.

Picture in Cell has fewer formatting options compared to the legacy Picture over Cells. Let me demonstrate. A Picture in Cell has a 
fixed aspect ratio (height-to-width ratio), and it cannot be changed by resizing the cell it resides in — see the screenshots “Fixed Aspect 
Ratio Examples”.

Fixed aspect ratio examples

The only exception is when using an IMAGE function to create a Picture in Cell and changing the function arguments (more anon).
The size of a Picture in Cell is also limited by the cell containing it. You may increase the cell’s height and width to enlarge the 

picture inside, but Excel has a maximum row height of 409 cm and a maximum column width of 255 characters — so that is as large as 
the picture can be (see the screenshot “Enlarging the Picture in Cell”).

Enlarging the Picture in Cell

One way to work around this limitation (if you really want to have an enormous image in a single cell, that is) is to merge cells 
vertically and expand the relevant rows (see the screenshot “Working Around Picture in Cell Size Limitation”).
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Working around Picture in Cell size limitation

You can further expand rows 12, 13, and 14 to a height of 409 cm, and this will work around the restriction. 
When Picture in Cell is being resized, it does not change the workbook size. If we consider our racoon above that is now occupying 

three rows, the Excel workbook has a present file size of 395 kilobytes:

If I revert to a compact unmerged square cell (48cm×8.43char) (see the screenshot “Reverting to Compact Unmerged Square Cell”), 

Reverting to compact unmerged square cell

the workbook remains 395 kilobytes:

Another formatting option to consider is that you cannot edit the colours of a Picture in Cell, whereas this is an option for the legacy 
Picture over Cells. However, I may still fill colours in the cell containing the image.

When pictures are inserted into cells, Excel handles them much like values (eg, numbers or text). You may copy and paste a Picture 
in Cell, and you may even use it in a formula to produce formulaic graphical outputs.

Here, I have prepared an example with the 12 Chinese Zodiac animals (see the screenshot “Chinese Zodiac Animals”).
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Chinese Zodiac animals

I built the input images from Excel’s Stock Images… . To demonstrate, let’s take the animal Rat as an example. Select the cell where 
the image should be inserted (here, cell G8), and then go to the Insert tab and Pictures -> Place in Cell -> Stock Images… . (See the 
screenshot “Using Place in Cell to Insert a Stock Image”.) 

Using Place in Cell to insert a stock image

 
This will open up the Search window (see the screenshot “Search Window”).
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Search window

I then searched and found a rat icon and inserted it. Repeating this exercise for all 12 animals completed the input table, with 12 
pictures in cells for the 12 Chinese Zodiac animals.

I also inserted the input as a Table (CTRL+T), called ZodiacTable, for formula transparency. In our output, I may use XLOOKUP 
to return the Chinese Zodiac animal for a certain year and, more importantly, the corresponding logo (see the screenshot “Using 
XLOOKUP and a MOD Formula”).

Using XLOOKUP and a MOD formula

=XLOOKUP(MOD($G$24 - 2020, 12) + 1, ZodiacTable[Index], ZodiacTable[Zodiac Animal])

Here, I have used a MOD formula to calculate which zodiac animal a certain year relates to:

MOD($G$24 - 2020, 12) + 1

I have used the year 2020 as my basis as I know it is a Year of the Rat, the first in the cycle. The MOD function will take the value in 
cell G24 (anchored), subtract 2020 from it, and divide the result by 12 (the number of different years in the cycle). This will provide a 
remainder between zero [0] and 11 inclusive. Adding one [1] results in a value from 1 to 12 instead. Wrapping this MOD expression in an 
XLOOKUP calculation, I may find the animal for a year:

=XLOOKUP(MOD($G$24 - 2020, 12) + 1, ZodiacTable[Index], ZodiacTable[Zodiac Animal])
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Then I may make a similar formula to return a Picture in Cell, ie, the relevant logo:

=XLOOKUP(MOD($G$24 -2020, 12) + 1, ZodiacTable[Index], ZodiacTable[Logo])

Now I have a dynamic Picture in Cell indicating the Zodiac logo of a year! (See the screenshots “Examples Indicating a Year’s Logo”.)

Examples indicating a year’s logo

IMAGE function
Now, let’s turn our attention to the aforementioned IMAGE function. This function inserts images into cells from a source location 
along with alternative text. It has the following syntax:

=IMAGE(source, [alt_text], [sizing], [height], [width])

The arguments are as follows:
  y source is required and represents the URL path of the image file, using an https protocol (it should be noted that supported 

file formats include BMP, JPG, JPEG, GIF, TIFF, PNG, ICO, and WEBP). Upon modifying as required, cell references within the 
workbook appear to be recognised, too.

  y alt_text is the first optional argument. This is the alternative text that describes the image (for accessibility purposes).
  y sizing is also an optional parameter and specifies the image dimensions. There are several possible values:

  ○ 0: Fit the image in the cell and maintain its aspect ratio (default).
  ○ 1: Fill the cell with the image and ignore its aspect ratio.
  ○ 2: Maintain the original image size, which may exceed the cell boundary.
  ○ 3: Customise the image size by using the height and width arguments (see below).

  y height and width are optional arguments. These define the height and width, respectively, of the image only when using 
sizing option 3 (see above).
Let’s look at a few examples. You can insert a sphere into a cell with the formula:

=IMAGE("https://support.content.office.net/en-us/media/2d9e717a-0077-438f-8e5e-f85a1305d4ad.jpg", "Sphere")

(See the screenshot “Inserting a Sphere Into a Cell”.)

Inserting a sphere into a cell 

 

We could also use cell references to be flexible and transparent — see the screenshot “Using Cell References”.
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Using cell references

As for the different sizing options, the default option, zero [0], fits the image in the cell and maintains its aspect ratio. Option 1 fills 
the cell with the image; option 2 maintains the original image size; and option 3 customises the image size by using the height and 
width arguments (see the screenshot “Different Sizing Options”).

Different sizing options

.
Moreover, we want to show you some creative graphics tricks for Data Validation (ALT+D+L) lists, using the IMAGE function 

together with alternative text. I have listed a few geometrical shapes from Microsoft and used IMAGE formulae to insert them into cells 
and then created a Table (CTRL+T) called DVimage (see the screenshot “Geometrical Shapes Inserted Using IMAGE Formulae”).

Geometrical shapes inserted using IMAGE formulae

Then, I have created a Data Validation dropdown list with the column of images using Data -> Data Validation -> Data 
Validation… (see the screenshot “Creating Data Validation Dropdown List”).
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Creating Data Validation dropdown list

By generating this dropdown list, you will see that the descriptive alternative text is used for the list but, once selected, displays the 
respective image instead — see the screenshot “Display of Respective Image”.

Display of respective image

 
Display pictures in PivotTables
We can even use pictures inserted in cells for PivotTables.

For example, we can use country flags for a sales dataset. Let’s consider a sample sales dataset from Microsoft — see the example 
Excel file.

In the sales dataset, we can change Data Type of the Country column to Geography (see the screenshot “Changing the Data Type to 
Geography”).

https://www.fm-magazine.com/content/dam/fmm/issues/2024/aug/sp-excel-and-pictures.xlsx
https://www.fm-magazine.com/content/dam/fmm/issues/2024/aug/sp-excel-and-pictures.xlsx
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Changing the Data Type to Geography

Then, I can access other information from a Geography type (including flag images). We insert the above as a Table (CTRL+T) called 
PivotData. I insert a column Flag and use the dot operator (.) to get the flag images of the countries (see the screenshot “Inserting a 
Column Flag”).
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Inserting a column Flag

=[@Country].Image

Then we are able to insert a PivotTable and use images from the column Flag, in either row or column fields — see the screenshots 
“Using Flags in PivotTable columns” and “Using Flags in PivotTable Rows”.
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Using flags in PivotTable columns

We can use inserted images as row and column fields. However, filters and slicers are not that sophisticated — yet!

Using flags in PivotTable rows

 

Do remember that this is a feature for pictures inserted into cells only. It is not for the legacy floating images over cells. You should 
also note that presently we cannot load and process inserted images into Power Query.

Word to the wise
Hopefully, this has been a useful discussion for you, providing plenty of ideas for future reports, charts, dashboards, and other 
visualisations in Excel. Presently, much of this only works in Excel 365 — and then sometimes only in certain versions. 

Please don’t let that put you off. The future is coming, and every picture you add can potentially replace some reports.   ■

Liam Bastick, FCMA, CGMA, FCA, is director of SumProduct, a global consultancy specialising in Excel training. He is also an Excel MVP 
(as appointed by Microsoft) and author of Introduction to Financial Modelling and Continuing Financial Modelling. Send ideas for 
future Excel-related articles to him at liam.bastick@sumproduct.com. To comment on this article or to suggest an idea for another article, 
contact Oliver Rowe at Oliver.Rowe@aicpa-cima.com.  
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mailto:Oliver.Rowe@aicpa-cima.com
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ENGAGE 24 UK&I: 8–9 October

AICPA & CIMA’s Contemporary Issues in Management 
Accounting series

T he UK & Ireland ENGAGE two-day management accounting 
conference, awards, and dinner takes place 8–9 October in person in 

London and online. It provides sessions for early-career and experienced 
professionals and senior business leaders to learn — and opportunities 
to network. 

Awards will be presented in these categories: 
  y Rising Star of the Year
  y Finance Business Leader of the Year
  y Responsible Finance Team of the Year
  y Digital Innovation Project of the Year
  y Small, Medium Enterprise of the Year
  y Public Sector Team of the Year
  y Student of the Year

#CIMA #Engage24 #FinanceAwards24

The following research executive summaries were recently published in the series of academic research supported by CIMA:

1 

United or Divided?

CIMA Research Executive Summary 
Vol. 20 Issue 5

Governance mechanisms for 
integrating ESG into business practice

1 

CIMA Research Executive Summary 
Vol. 20 Issue 6

Challenges in reporting on the 
United Nations Sustainable 
Development Goals:
A management accounting focus

Challenges in Reporting on the United Nations Sustainable Development Goals:  
A Management Accounting Focus 
This research, led by Matteo Molinari, Ph.D., senior lecturer in accounting and finance at 
the University of Roehampton in the UK, explored how management accountants within a 
large Italian multi-utility company contributed to the reporting on two UN Sustainable 
Development Goals (SGDs) (Goal 7, Affordable and Clean Energy; and Goal 13, Climate 
Action), both of which are particularly relevant to companies operating in environmentally 
sensitive industries.

The study provides insights into the ways management accounting and control 
practices are adopted, help to align the activity of organisations with the expectations of 
stakeholders, and contribute to overcoming reporting challenges with SDGs.

United or Divided? Governance Mechanisms for Integrating ESG Into Business 
Practice 
This case study was led by Sarah Russo, Ph.D., assistant professor in business 
administration at the Competence Centre for Economic, Ecological, and Social 
Sustainability at the Free University of Bozen-Bolzano in Italy. It looked at the 
integration of environmental, social, and governance (ESG) considerations within 
business practice and corporate reporting. 

The case study was conducted on an EU-based, state-owned sustainable  
energy company that successfully incorporated ESG factors into its business  
operations. The study outlines some of its best practices and makes further 
recommendations.

https://ukandi.aicpa-cimaengage.com/
https://www.aicpa-cima.com/professional-insights/download/challenges-in-reporting-on-the-united-nations-sustainable-development-goals
https://www.aicpa-cima.com/professional-insights/download/challenges-in-reporting-on-the-united-nations-sustainable-development-goals
https://www.aicpa-cima.com/resources/download/united-or-divided-governance-mechanisms-for-integrating-esg-into-business
https://www.aicpa-cima.com/resources/download/united-or-divided-governance-mechanisms-for-integrating-esg-into-business
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AICPA & CIMA establish Latin 
America Research Centre

CIMA seeks CPD and practising certificate assessors

A ICPA & CIMA, together as the Association of 
International Certified Professional Accountants, have 

founded a new research centre in Latin America. 
The Latin America (LatAm) Research Centre, established 

to foster innovative research in Latin America, collaborates 
with universities, the public sector, and companies in the 
region. The centre’s mission is to develop cutting-edge 
research, promote best practice, and drive innovation in 
management accounting to meet business needs. 

The LatAm Research Centre is the latest AICPA & CIMA 
centre supporting global management accounting research 
to be established, joining those in Australia and New 
Zealand, Central and Eastern Europe, and Southern Africa. 

A call for research proposals focused on contemporary 
issues in management accounting in Latin America will be 
launched in autumn 2024. 

C IMA is looking for volunteers to join its panel of CPD 
assessors or become CIMA practising certificate assessors.

CIMA CPD assessors play an important role in ensuring the 
highest standard of members’ CPD. A CPD assessor can be 
either a member currently working in business or in practice. 

Assessors use their experience and knowledge by assessing 
member records received within the CPD monitoring year for 
quality assurance purposes. 

The assessment exercise entails assessing CPD records 
against defined criteria to ensure members meet regulatory 
requirements and are working within CIMA’s CPD Cycle. 
More information on CIMA CPD can be found on the AICPA & 
CIMA website. 

Practising certificate assessors help maintain the 
integrity of CIMA’s practising certificate. They assess  
the competency and experience of members wishing  
to make the move into practice.

Practising certificate assessors must have a minimum  
of five years working in practice with no gaps. They must  
be able to use their knowledge of being in practice to 
assess new Member in Practice applications, giving 
constructive feedback to the applicants when required.

To find out more or to apply to become a CPD assessor  
or a practising certificate assessor, please email  
prof.standards@aicpa-cima.com, including a copy of 
your CV. 

https://www.aicpa-cima.com/membership/landing/cpd-requirements
https://www.aicpa-cima.com/home
https://www.aicpa-cima.com/home
mailto:prof.standards@aicpa-cima.com
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T he Association of International Certified Professional 
Accountants Nominations Committee, composed of CIMA 

and AICPA members, will convene in February 2025 to 
nominate members for the Association’s board of directors, its 
chair, and co-chair and to select committees with terms from 
June 2025 to May 2026.

These committees include the Management Accounting 
(MA) committees (Lifelong Learning Committee, CGMA Exam 
Board, and Thought Leadership and Business Ethics 
Committee) and the eight Regional Engagement Groups (REGs).

In July 2019, the Association’s MA board of directors voted to 
have all seats for the Lifelong Learning Committee, CGMA Exam 
Board, and Thought Leadership and Business Ethics Committee 
determined by the Nominations Management Accounting 
Subcommittee. CIMA Council approved this resolution in 
October 2019 with the objective of building a strong pipeline of 
volunteer talent, providing opportunities for rotation of the 
Association’s broad and diverse membership, and ensuring 
candidates are fit for purpose.

All individuals interested in serving on the Lifelong 
Learning Committee, CGMA Exam Board, and/or the Thought 
Leadership and Business Ethics Committee should complete 
and submit an online form to ensure a common set of 
information on each candidate is received. 

All individuals interested in serving on the REGs should 
complete and submit an online form to ensure a common set 
of information on each candidate is received. 

All nominations must be received by 17:00 GMT on 6 
January 2025. For questions and inquiries regarding 
submitting a nomination, please contact the Association’s 
Governance team at VolunteerServices@aicpa-cima.com or 
one of the following Association staff liaisons:

MA committees
  y Lifelong Learning — Stephen Flatman,  

Stephen.Flatman@aicpa-cima.com. 
  y CGMA Exam Board — Tracey Fabiyi, 

Tracey.Fabiyi@aicpa-cima.com.
  y Thought Leadership and Business Ethics — Ash Noah, 

CPA, FCMA, CGMA, Ash.Noah@aicpa-cima.com. 

Regional Engagement Groups
  y Africa — Tariro Mutizwa, ACMA, CGMA, 

Tariro.Mutizwa@aicpa-cima.com, and Kerry Smith, 
Kerry.Smith@aicpa-cima.com.

  y The Americas — Tom Hood, CPA/CITP, CGMA, 
Tom.Hood@aicpa-cima.com, and Ken Witt, CPA, CGMA, 
Ken.Witt@aicpa-cima.com. 

  y Australasia — Venkkat Ramanan, FCMA, CGMA, 
Venkkat.Ramanan@aicpa-cima.com, and Justine Mills, 
Justine.Mills@aicpa-cima.com. 

  y Mainland Europe — Jakub Bejnarowicz, 
Jakub.Bejnarowicz@aicpa-cima.com. 

  y MESANA — Venkkat Ramanan, FCMA, CGMA,  
Venkkat.Ramanan@aicpa-cima.com, and Antoinette 
Jayamohan, Antoinette.Jayamohan@aicpa-cima.com.

  y North Asia — Vicky Li, FCMA, CGMA, 
Vicky.Li@aicpa-cima.com, and Amy Shen, 
Amy.Shen@aicpa-cima.com.

  y South East Asia — Venkkat Ramanan, FCMA, CGMA, 
Venkkat.Ramanan@aicpa-cima.com, and Antoinette 
Jayamohan, Antoinette.Jayamohan@aicpa-cima.com.

  y UK & Ireland — Paul Turner, FCMA, CGMA, 
Paul.Turner@aicpa-cima.com. 
Candidates will be notified of their status in March 2025.

Nominations to the 2025–2026 Association Regional Engagement 
Groups and Management Accounting committees
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https://forms.office.com/r/9P28YB7v8w
https://forms.office.com/r/nGt6yavGfL
mailto:VolunteerServices@aicpa-cima.com
mailto:Stephen.Flatman@aicpa-cima.com
mailto:Tracey.Fabiyi@aicpa-cima.com
mailto:Ash.Noah@aicpa-cima.com
mailto:Tariro.Mutizwa@aicpa-cima.com
mailto:Kerry.Smith@aicpa-cima.com
mailto:Tom.Hood@aicpa-cima.com
mailto:Ken.Witt@aicpa-cima.com
mailto:Venkkat.Ramanan@aicpa-cima.com
mailto:Justine.Mills@aicpa-cima.com
mailto:Jakub.Bejnarowicz@aicpa-cima.com
mailto:Venkkat.Ramanan@aicpa-cima.com
mailto:Antoinette.Jayamohan@aicpa-cima.com
mailto:Vicky.Li@aicpa-cima.com
mailto:Amy.Shen@aicpa-cima.com
mailto:Venkkat.Ramanan@aicpa-cima.com
mailto:Antoinette.Jayamohan@aicpa-cima.com
mailto:Paul.turner@aicpa-cima.com
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Games wide open

T he excitement and challenge of the 
Olympic and Paralympic Games combine 
to create events watched across the planet. 
More than 3 billion people watched the 
2020 Tokyo Games on linear TV or digital 

platforms, according to the International Olympic 
Committee. Engagements on official social media 
handles totalled 6.1 billion.

And Paris 2024 promises much on the field and 
track — and economically. Beyond broadcasting and 
marketing revenues, research on the London (2012) 
and Rio de Janeiro (2016) Games found that tourists 

travelling for the Games spend on average twice as 
much as standard tourists.

However, with an average Olympics budgetary cost 
overrun of 172% since the 1960 games, there is always 
a question around their costs versus benefits. One 
thing is clear: The economic impact is over a long 
period — an independent report by the France-based 
Centre de Droit et d’Economie du Sport estimates an 
€8.99 billion medium scenario impact from the 2024 
games on the Iles-de-France (Paris region) alone over 
a 17-year period from 2018–2034, covering the Games’ 
organisation, construction, and tourism.

A view of the Paris city hall on 4 March 2024 showing the 2024 Olympic and Paralympic Games’ visual identity.

https://cdes.fr/wp-content/uploads/2024/05/2024.04_Paris-2024_Economic-impact-study_final.pdf
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